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1. Excel 2010
Excel is the spreadsheet program from Microsoft, part of their Office suite

The sections listed here are the requirements for the ECDL level 2 Excel exam.

2. Maths with Excel
2.1 Essential Maths skills
.

Some formulae follow the equal sign with a built-in function such as SUM or AVERAGE. Many simple 
formulae use a series of values or cell references that contain values separated by one or more of the
following mathematical operators:

This Mathematical Operator . . . . . . Is Used For Example

+ (plus sign) Addition 6+5

- (minus sign or hyphen) Subtraction 8-5

* (asterisk) Multiplication 21*3

/ (forward slash) Division 48/6

^ (caret) Raising a number to an exponential power 4^2 = 42 = 16

Note: If you select the cell you want to use in a formula, either by clicking it or by moving the cell 
cursor to it, you have less chance of entering the wrong cell reference.

Note: Each cell can hold one of five types of data: Number, Text, Date, Formula or Logical value. 

The Logical values permitted are TRUE or FALSE.
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Some examples of calculations with Excel

Calculation / formula in
cell 

Operator Description

=4+7 + Addition will display 11

=8-3 - Subtraction will display 5

=4*5 * Multiplication will display 20

=24/3 / Division will display 8

=10^2 ^ Power (10x10) will display 100

=A1+B1 + Add the contents of cell A1 to the contents of cell B1

=(D4+E4)*A3
Add the contents of cells D4 and E4 then multiply the 
result by the contents of A3

D2+D3*F4
Multiply the contents of D3 and F4 together then add 
the result to D2 {see BODMAS}

Note that every calculation starts with an equals ( = ) sign in the cell before anything else.

You let Excel know you want to start a formula or calculation by placing an equals sign (=) as the first 
entry in a cell. It’s like saying this cell equals. 

When you enter a calculation into a cell Excel does the maths for you in a strict mathematical way. 

Excel follows all the basic rules of maths that you probably haven’t heard about, so in a calculation 
you must always do the maths in a strict order, NOT necessarily the order in which they are written 
on a sheet of paper.  Division first then multiplication followed by addition and finally subtractions. If 
brackets are involved then whatever is between the brackets must be done separately before doing 
the other stuff.

6 + 4 * 5 = ?

You might think the answer is 50, (6 plus 4 is 10 times 5 is 50), but that is not so. Multiplication 
comes before Addition so you multiply 4 times 5 to get 20 then add on the 6 to give you 26.

6 * 4 + 5 = ?

Here the answer you calculate is the same as the way it is written i.e. 6 times 4 is 24 plus 5 is 29

Multiplication is done first then addition
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There is a mnemonic to help you remember this BODMAS 

Brackets

Order (bit too advanced for inclusion here, basically the power of a number eg 102 = 10x10 = 100)

Division

Multiplication

Addition

Subtraction

So for the equation A+B*C you must first multiply B times C and then add A to the answer. You do not
add A and B. Mathematical rules are not like grammar rules!

If you do want to add A and B first then multiply that answer by C you would need to write (A+B)*C 
because everything in brackets is calculated separately

 Calculate the following equations

3 + 5 * 7 =

( 24 - 8 ) - 2 / 2 =

5 + ( 6 + 4 )2 = 

 Enter the calculations above to check your answers
 Enter 23 in cell C3, 45 in cell C4, and 36 in cell C5 Now enter the same numbers in cells E3, 

E4, and E5 then again in cells G3, G4, and G5
 Below each of the sets of numbers write a calculation to add the numbers in each column 

(Use as many different ways as you can. A solution to this can be found in the file 
solution 1.xlsx).

Note: don’t forget the = sign as the first character in any cell containing a calculation or formula.
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3. Tutorial
3.1 The Basics
3.1.1 Starting Excel 2010
There are several different ways to start Excel 2010

Click the Start button – click All Programs – click Microsoft Office – click Excel 2010

This process of finding the program you want to start (launch) is referred to as Navigating to the 
program.

Opposite you can see the route to the 
excel 2010 program by going via the 
start button then All Programs then 
Microsoft Office and finally clicking on 
Microsoft Excel 2010 

You can also click on the Excel launcher

icon  wherever you see it, usually 
in the Start Menu or the Task Bar. You 
can also launch Word by clicking on 
the document icon you want to work 
on.

When you launch Excel it will open 
with a blank workbook on the screen as illustrated below.
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3.1.1 The Excel 2010 Screen

Title Bar
This tells you the name of the application running in this case Excel and the name of the 
document being used Book1 (You don’t see this on the image above, it’s covered over)

Quick Access toolbar
This allows you quick access to the commands you use frequently. It can be customised to 
suit your personal preferences. The drop down arrowhead to the left of the quick access bar 
opens a dialogue for you change the settings.

The Ribbon
This is Microsoft’s big change that occurred with Office 2007 and further refined with Office 
2010. It replaces the idea of drop down menus with a series of ribbons each with a set of 
icons that provide a context sensitive focus. Each ribbon tab provides the tools for a 
particular set of actions or commands within excel. For example the Insert tab includes tools 
for adding charts, shapes, pictures, hyperlinks bookmarks etc. Each ribbon is sub divided into 
several groups, each separated by vertical lines. The group name appears underneath the 
tools.

Ribbon Tabs
File, Home, Insert, Page layout, Formulas, Data, Review, View. Each of these tabs has a 
focus on a particular aspect of spread sheet work. The File tab gives access to actions such as
Save Open Close and New which of course applies to the Excel files themselves, hence the 
tab name. There are additional actions such as Print and also it is here that you can set the 
Excel Options.
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Ribbon groups
On each of the ribbon there are many tools, the Ribbon itself has been sub divided into 
groups. Each group displays the most used features of that group but there are still some 
that cannot be displayed because of the space required. To overcome this other tools in the 
group can be seen by opening the Group Dialogue Box using the small arrow at the bottom 
right of the group. Once the group dialogue box is open all the commands become available.

Formula Bar

T
his is divided into two spaces. On the left is the Name Box, it displays the cell reference or 
name and on the right, the Formula Box displays the contents of that cell. The cell itself is 
called the Active Cell. Between the two are the accept and reject icons, used to accept or 
reject any changes made to the contents of the cell. Alongside this is the function selector 
icon. Finally on the extreme right is the Expand Formula Bar button. 

Column letters Row numbers and Cells
The columns of the spread sheet are labelled with letters and the rows with numbers. The 
cell reference is the letter and number combination of the active cell. The Name Box shows 
you which cell is currently selected F2 in the diagram above. 

Worksheet tabs
At the bottom of the sheet of cells is a series of tabs that are used to switch between three 
different worksheets. More sheets can be added by clicking on the add sheet tab on the right
of these. The sheets can be given sensible names by double clicking the tabs or right clicking 
and selecting rename.

Status Bar
The status bar will include from time to time information that is useful to the user. In 
particular it will display the Average, Count and Sum of any group of selected cells
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Zoom Bar
The zoom bar can be used to increase or decrease the size of the sheet.

View icons
There are 3 view icons that can be accessed on the right of the status bar. They are Normal 
view, Page layout view and Page break preview, the latter where you can choose where 
pages can be shaped.

Tool Tips
If you hover the mouse pointer over any icon on the ribbon then the name and purpose of that icon 
is displayed.

Hiding the Ribbon
The Ribbon though very useful can also get in the way. If you prefer to see only the Ribbon Tabs not 

all the ribbon you can hide it with the up arrow head next to the help option 

Application Options 
Changing the username, setting the default open and save locations, defining your proofing 
preferences etc. can all be done in the option choices found under the File tab – Options choice.
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Getting Help
To get help, you click on the help button on the top right of the screen. It is the white question mark 
in the blue circle. Alternatively you can press the F1 function key.

If you hover the mouse over part of the ribbon you need help with and then press the F1 key, help 
regarding that feature will be displayed. It is worth noting that this feature does not always provide 
useful help.

3.1.2 Familiarity with the workbook
The heart of Excel is the worksheet. Every time you open a new workbook the cells of the worksheet 
Sheet 1 are shown. There are in fact three worksheets available by default, labelled Sheet 1, Sheet 2,
and Sheet3. Next to sheet 3 is the Add sheet tab which adds another sheet. Each worksheet is a grid 
of cells set out in rows and columns. The rows are numbered from 1 up and the columns labelled 
from A on. The exact number of rows and columns is very large but finite.

If you want to focus on a particular cell you simply click the mouse button while hovering over the 
cell. Once you have selected a cell, the reference of that cell, let’s say D5, is the letter of the column 
and the number of the row that intersect with the cell.  As well as clicking on a cell you can also type 
the cell reference into the Name box to the left of the Formula Bar.
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3.1.2.1 Accessing the Excel Tools
Each of the tools (The icons on the ribbon) have a toggle effect. Clicking on a tool once produces the 
action required. Clicking the same icon again turns the action off.

 . Click on the cell A10 then on the Bold tool in the Font Group, (it’s the letter B). Enter Total 
in cell A10. Note how the font is darker. To un-bold the text first click away from the cell then 
back on it. Click the Bold tool again and the Bold will be removed.

Note: If you were to type To then click the Bold tool and type tal you wold see Total

Note: If you change cells you will have to click Bold again if you want the new cell to be bold.

 Enter the following numbers into a column of cells starting with cell B2

56
876

87
98
56

 Using the tools in the font group only add a Border around them, fill the cells with a colour of
your choice and then give the numbers a colour of your choice. Be careful that the fill colour 
and the character colour don’t clash.

Your result could look like this

56
876

87
98
56

3.1.2.2 Keyboard Shortcuts
If you don’t have a mouse it is possible to select the tool by using the keyboard.

This is done with the help of the Alt key. 

 Press the Alt key and notice the letters that appear alongside the tabs on the ribbon. 

Keying these letters open the corresponding tab ribbon. The ribbons each have their own set of 
letters to activate tools so it is possible to use excel without a mouse. (I wouldn’t want to have to do 
that!)

P for example opens the Page Layout tab. 

 Using the Alt key and keyboard only open the Page Layout ribbon and set the page 
Orientation to Landscape 
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3.1.3 Filenames 
With Excel 2010 you can have file names with up to 255 characters. These file names can include 
spaces but not ? * \ / 

Excel 2010 documents are saved with the file extension .xIsx, This is different to the earlier versions 
of Excel which used the .xls extension. I remember this by thinking of the x as 10 although xIsx is also 
the extension for word 2013.

When you save a workbook Excel will automatically give it the .xIsx extension. You can save a 
workbook with the .xls extension by choosing the Save as Excel 97-2003 Workbook option. (This is 
necessary if you want to send your work to a colleague who does not have the latest version of 
Excel).

 Save the workbook you have just created. 
 Click on the Save button on the Quick Access Toolbar 

OR 

 Click the File tab and chose Save. 
 When the Save As dialog box appears, type the filename Business Plan in the File Name box.
 In the Save In list box select the folder in which to save the file. 
 Click the Save button. 
  Finally close the document by clicking on the document Close button or selecting the File 

tab and Close. 

If you have changed anything in the document between saving and closing, you will be asked if you 
want to save changes. 

Note: When you save a workbook in Excel you save all the worksheets in that workbook.

3.2 Entering Data
Use the data provided below to create your own spread sheet.
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You could enter all the values of the cells directly, if you did 
how would that affect changes you may have to make in the 
future? Try calculating the totals by typing a formula into the 
appropriate cell, for example you could click on cell B7, to 
select the cell and then type

 = B4+B5 +B6 

This will add up the income for July. Of course this will need to 
be changed if your figures were in row C not B.

Note Some of the text is covered by column B. How do you 
uncover this? You may have to look back if you don’t 
remember.

 The Answers? B7 £2070, B15 £1095 and B17 £975

Save this spread sheet with the file name Business plan

Use the  button at the top left of the title bar to do this.

Things you need to consider when you save a file.

1 Where will you save the document and how will you remember this place?

2 How will you keep the file up to date?

3 Who will you want to share the spread sheet with and will they be able to open it?
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3.3 Formulae
Formulae (calculations) are really what Excel is good at.

Open Excel and type the following into a new sheet

In Cell C8 we will need to type the calculation to add all the items from C2 to C7.

You could use: = C2+C3+C4+C5+C6+C7

However you could also use the inbuilt SUM function

=SUM(C2:C7)

This shorthand method saves you a lot of typing.

Click on the Sheet 2 tab at the base of the workbook, this displays the empty worksheet Sheet2

Enter the following table and then enter amounts that you think appropriate.

In Cell F2 write a formula to calculate the total spent on food over the four week period

In Cell B9 write a formula to calculate the total amount spent in week 1

Save this workbook as Home Budget.xlsx
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3.2.1 Opening a document 
Open an existing document in Excel can be achieved in a variety of ways.

If Excel is not already open then navigate to the file you want and double-click on it. 

If Excel is already open click on the File tab and select Open when the dialogue box appears click on 
the name of the file you want to open. 

If you have recently used a file it will be in the Recent Files list. Click on the File tab and select the file
you want from the list.
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3.2.2 Text and Columns
When text in a column is hidden by other columns it may be tedious to widen the column, especially 
if the data spreads over several sheets. Fortunately there are quick ways of Automatically fitting the 
cell width to the text

Double clicking in the column header boundaries, (with the   mouse pointer), will expand the 
column to fit the largest piece of text.

Alternatively in the Home ribbon find the Cells group and click the Format icon. You can select 
Autofit Column Width (Note: also AutoFit Row Height) to achieve this.

 Open the file IF Exam results.xlsx and adjust the column widths so that all the text 
will remain visible.
 Save the spreadsheet as Exam results<your initials>.xlsx

3.2.3 Multiple Documents 
In Excel you can work with several documents open simultaneously. As each new document is 
created or opened it hides the previous documents. Only the last document opened will be seen. 
Later we will learn how to Save and Open multiple workbooks together.

The close file options in Excel are different to those of Word.
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The Autofill handle

3.2.4 AutoFill
Using Autofill

 If it is not already open, open the workbook Business Plan

Now let’s consider the results we may collect over say a three month period.

 Enter this new data in your spread sheet.



The months can be added easily by selecting July and using Autofill handle, click and hold 
the black cross that will appear in the bottom right corner of the cell and without letting go 
of the mouse button drag the pointer to the right and you will fill the cells with consecutive 
months. Enter August and September using this technique. (Autofill can also be used to fill in 
numbers and formula into cells). 
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3.2.5 Adding up a range of cells
In order to sum the rows and columns we use the sum function e.g.  =SUM(B3:B5) 

(B3:B5) is called the range of the cells.  That is all the cells between B3 and B5

This function can also be invoked using the ∑ AutoSum (Sigma) character on the Home 
ribbon Editing group.

Note the shimmering outline on the cells that have been selected for the calculation. This 
allows you to quickly check the range is what you want. If you want a different range you can 
select this by clicking on the start cell and dragging the mouse to the end cell. If the range 
you want is not contiguous you can use the Ctrl key while selecting. (You'll need to practice 
this to get it right).

Once one formula has been entered for a row or column it can be copied to the other rows / 
columns by also using the Autofill option.

Note: the solid black cross hairs without any arrowheads indicates the Autofill option is 
active

 Complete the Totals in the example using the Sum function.

 Use the Autofill tool to copy the calculations to the other cells
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3.2.6 Autofill and Absolute References
3.2.6.1 Autofill
One unintended consequence of Autofill is that it is possible to copy formulae in such a way as to 
create errors. This happens when we copy a cell with a formula that refers to a value you don’t want 
to change.

Say we have several columns of
numbers we want to add up.
Generally when you echo a cell with
a formula, as below, then you want
all the references in the cell to
change. In this case as we copy the
cell, C7, to the right we want both C3
and C6 to increase for each column.
So in column D we get D3 and D4 and
in column E we get E3 and E4. This is
of course what happens.

 

But what if we were to add into the formula a component to calculate the VAT from a cell as in the 
next example.

If we were to echo this formula, as it stands, across the cells then we would have a problem. 
C1 would become D1 then E1. But we want C1 to be the same in both rows D and E. To make
C1 an absolute reference, as it is called, we put a $ in front of the C. So since we don't want 
the column to change from C we would type $C1 before we used the Autofill handle. 

If you haven't already, use the Autofill handle to calculate the cost of all the items including 
VAT. Add the heading Cost inc. VAT to the appropriate row.

20 | P a g e



3.2.6.2: Absolute Reference / Sticking Cells
Create a new spread sheet called MC build and enter the details listed below.

  

Save this worksheet as MC build.xlsx

Calculate the VAT payable on the main board only. To do this you need to multiply the value in the 
Cost ex VAT (C3) column by 20%.

You need to make sure any change in VAT can be easily re-calculated if necessary.

One way to do this would be to put the VAT value into a single cell, say E1. That way the VAT could be
easily changed when necessary. Obviously all for this to work references to VAT would have to 
reference this cell

Your task now is to repeat the calculation for each item in the component list. To do this you could 
type the calculation in each appropriate cell. However this would be tedious and time consuming. 
You could use the Autofill handle to help you with this task. Try it and see what happens.

As you fill down the column the cell reference for VAT changes by incrementing its row value. E1 
becomes E2 and so on down the column. So E1 in the main board calculation would change to E2 for 
the PSU calculation and E2 is empty. To stop this happening we need to stick the cell reference to E1. 
Putting a $ sign in front of the row or column you want to stick accomplishes this. So, since we don't 
want the row to change from 1, we would type E$1 before we used the Autofill handle. 

If you haven't done so already, use the Autofill handle to calculate the cost of all the items including 
VAT. Add the heading Cost inc. VAT to the appropriate column.

 Before you finish make sure your spreadsheet is looking presentable
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3.2.7 Sorting data
To do this exercise, open the file Sort1

Note: Before you use this file make sure all the text is visible. This is not strictly necessary but I want 
you to do this to practise the things we have learnt.

To quickly sort a list simply click on the sort icon in the Home ribbon. You can easily sort items in 
ascending or descending order. Note Excel by default expects a header on each column. If your data 
does not have a header then select Custom Sort and uncheck the My data has headers check box. 

Note: Generally it is not a good idea to try to sort data without taking care to plan ahead.

Sort1 contains the names of customers of a particular company. The sales director wants to see the 
areas where his clients are based. The quickest way of doing this is to sort the list by postcode.

 Sort the data in sort1.xlsx by postcode

Select the data you want to sort. If there are no empty rows or columns then you can simply select 
any cell in the table. This is not, however, recommended.

Select Sort and Filter from the Editing group in the Home ribbon. From the drop down menu select 
custom sort. The first thing to note is if your dialogue box has the My data has headers check box is 
checked. If your data does have headers, and most data tables do, then this box must be checked 
else the top row will be treated as any other row. Try clicking the Sort by selector, first with the My 
data has headers check box checked then without it checked. You will see the first column headers 
are available to be selected or else just the column letters.

Select the Pcode header and click OK. 
The data is now sorted in Pcode order.

You can also filter the data by turning 
on the Filter icon. Once the filter is on, 
use the arrow in the column headers to
choose a filter for the column. You can 
add levels to your filter with the Add 
level selector. 

 Open the file Hotel Visitors.xlsx and Sort the data in order of Hotel (column A).
 Save the workbook as Hotel visits.xlsx
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3.2.8 Error Messages
There are several messages that pop up from time to time should you make a mistake in 
formulae that you might use. Four of the common ones are

 #Div/0! This occurs if you attempt a calculation that divides by zero, anything divided by zero
is infinite which is a concept Excel can't cope with.

#Value! This error occurs when you try to mix types of data. Adding numbers and text for 
example.

#Ref! This occurs when a cell reference is not valid, usually because a cell that is being used 
has accidentally been deleted.

The last error on our list occurs when we try to add (or any other mathematical operation) a 
cell to itself. This is called a circular reference and a warning box will appear.

3.2.9 Formatting Cells

3.2.9.1 Formatting Numbers
It  is  possible  to  change  the  way
numbers  and  text  are  displayed
using  the  Number group  on  the
Home ribbon. There are a number
of  commonly  used  formats
displayed but these can be added
to  by  opening  the  number  group
dialogue box.

Some common formats.

General as the name implies a 
general format for numbers and 
text.

Number allows you to change such things as decimal places and commas.

Currency allows $, £ and € symbols. It also allows you to set the number of decimals and the 
colour and sign of negative numbers. The currency symbol is alongside the number unlike 
with accounting            £23

Accounting similar to Currency. Biggest noticeable difference is that the £ sign is separated 
from the number £           23

Date changes the date format

Time similar to date

Percentage formats 0.05 as 5% 0.1 as 10% and 1.15 as 115%

Apply some of these formats to the appropriate cells in the spread sheets you have created.
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3.2.9.2 Borders and Shading
It is often useful to add borders and shading to a spread sheet in order to help identify key 
information. These additions can be achieved with the Font group on the Home ribbon or 
with the number group dialogue box.

3.2.9.3 Headers and Footers
Headers and Footers in Excel can be found on the Insert ribbon. 

They are also available through the Page Setup group on the Page Layout dialogue box

 Add Headers and Footers to your documents as you progress through this workbook
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3.3 Functions
Note: In Mathematics a function is a calculation that provides a single number answer.

3.3.1 Basic Functions
We have seen the SUM() function, we used it to add up a range of cells. 

This Function will add the numbers in cells B4, B5 and B6. The answer will be in cell E4.

So in the case above 12+6+8=26. Hence 26 will be displayed in cell E4 

We are now going to look at some other useful functions. 

They are:

AVERAGE(), MAX(), MIN(), COUNT(), COUNTA() and ROUND()

3.3.1.1 AVERAGE()
Finds the average of a given range of numbers. To find the average of a set of numbers we add them 
up and then divide by the number of numbers.

The average here is 12+6+8 = 26 divide this by 3 (the number of numbers) which displays 8.6667

3.3.1.2 MAX()
Returns the maximum number from a given range of numbers

12 would be displayed in the cell E4
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3.3.1.3 MIN()
Returns the minimum number from a given range of numbers

6 would be displayed in the cell E4

3.3.1.4 COUNT()
Returns the total number of cells with a number in in a given range of numbers.

Note: a 0 in a cell counts as having a number, a blank cell does not

 What would be displayed in cell E4

3.3.1.5 COUNTA()
Returns the total number of cells containing numbers and letters in a given range of numbers.

This can be useful for counting the number of names in a list for example.

 What would be displayed in cell D9
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3.3.1.6 ROUND()
Returns the rounded number.

This returns the number in D4 rounded to 2 decimal places.

This exercise will be based on 5 hotels and their visitors for the year.

 Copy the spreadsheet below into a new sheet

 Create a function in cell B7 that will display the total number of visitors visiting in spring.
 Copy this function to cells C7, D7 and E7
 Create a function in F2 that will display the total number of visitors for the year
 Copy this function for each hotel 
 Create a function in cell G2 that will display the average number of visitors for the year
 Copy this function for each hotel.
 Design a block of cells that will display the average, maximum and minimum visitors for all 

hotels
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3.3.2 The IF() function
This is a very useful function that allows Excel to make automated decisions. The syntax of 
the IF() function is

=IF(<Condition>,<True value>,<False value>)

Or to put it another way

=IF(<Apply a test>,<Do this if true>,<Do this if False>)

<Condition> eg A7>B7 (compares the values in cell A7 and B7. If A7 is bigger than B7 TRUE is 
registered otherwise FALSE is registered).

<True value> eg “YES” (displays a YES in the cell).

<False value> eg ”NO” (displays a NO in the cell).

For example =IF(D3>=50%,”Pass”,”Fail”)

This means IF a test such as Exam result in D3 is equal to or greater than 50% then print 
“Pass” if not then print “Fail”.

Note:

> means strictly greater than

< means strictly less than

>= means greater than or equal to

<= means less than or equal to

28 | P a g e



Exercise: Class exam results.

 Copy and complete the spread sheet above so that the results of all the pupils are displayed. 

 Save your work as “Exam results ANO” ANO would be your initials.

Exercise: A Stock control Application.
Imagine a stock control situation where stock levels are checked at the end of each month 
and updated with transactions that have happened during the month.

Use the data below to produce a spread sheet to do this.

Use appropriate formulae wherever possible including an IF() function!

Add the title “Stock Control Sheet” then merge and centre this title across the range (A1:G1)

Improve the readability of the sheet by selecting appropriate borders and design features.

Save the work as Reorder ANO where ANO is your initials

An almost finished file can be found in Reorder.xlsx
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3.3.2 Naming an array
It is possible to give a name to a range of cells that you intend to use. For example you might want to 
calculate the sum of a set of particular stock items, books say.  Select the cells you want to use click 
in the Name Box enter the name you want to use. “BookStock” maybe

3.3.3 Selecting Cells
Cells that are alongside each other (contiguous): On the first cell of the group you want to select click
and hold down the left mouse button while the large white cross is displayed. Then drag the mouse 
to the final cell you want to select and release the button. The range of cell you have selected will be 
highlighted and will remain selected until you do something to unselect them like clicking elsewhere 
on the sheet.

Cells that are not alongside each other (non-contiguous): This process is very similar to the one 
above except when it comes time to move to another range then you need to hold down the CTRL 
key at the same time as dragging.
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3.4 Using Charts
3.4.1 Inserting a chart
A normal sales chart (2D Clustered column).

We are going to produce a simple sales chat using the figures below. Type the data below into a new 
spread sheet and save it as June income. Highlight cells from A3 to F7. Select the Insert tab of the 
Ribbon bar and click the chart icon from the chart group. Select the clustered column chart. If you 
get a blank chart then it’s probably because you have forgotten to select the data beforehand. If this 
is the case simply click the Select Data icon and add the column headings (series names) and the 
column values (series values) as you require.

Support Training Sales Repair Web / Server
£0.00

£50.00

£100.00

£150.00

£200.00

£250.00

£300.00

Wk1
Wk2
Wk3
Wk4
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3.4.2 Moving a chart
 If you want the chart to appear on a sheet of its own then click on the Move Chart icon and type the
sheet name in if it is a new one (New sheet radio button) or select the sheet from the sheet names 
(Object in radio button) using the drop down arrow.

Chart Tools tab -> Design tab -> Location group

3.4.3 Formatting a Chart
When you select a chart by clicking on it a new tab appears. Chart Tools

 

Select the Design tab to Change the Chart Type, Chart Styles and Move the chart to another sheet.

Select the Layout tab to add a chart title, Axis Titles, Legend (Key), Data Labels, Data Tables. Format
the Plot and Chart areas with colours of your choice.
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Select the Format tab to Change the Colour, outline and style of objects within the chart. Text styles 
are also affected in this ribbon.

3.4.3.1 Adding a Title
Select the Chart Title button, select the position. Once the text box appears 

3.4.3.2 Adding Data Labels
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3.4.3.3 Adding the Key (Legend)
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3.4.3.4 Formatting chart objects
Open the Workbook Cost of Vegetables.xlsx

Create a column chart from the data. 

From the Chart Tools, Design tab investigate the various Chart Layout options. Select one of your 
choice. Try to include as many of the options from the last section as you can.

Ie Data Labels, Key, Chart Title etc.

3.4.3.5 Changing the colour, size, fill and effects of objects.
Select different objects on the chart by clicking them. 

3.4.3.6 Changing the colour, size, fill and effects of text.
Select text objects and change their colour and effects to something of your choice.
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3.4.4 A bar chart
Type the data below and select the range D2:G9. On the Insert Ribbon click the bar chart icon and 
then choose the stacked bar option.

 

Your chart should look something like this

Lord of the Rings

The Time Travellers Wife

The Algerbraist

Catch 22

The Kite Runner

The Odysseus

Master and Commander

0 20 40 60 80 100 120

24

12

2

4

12

1

56

25

14

4

7

15

2

28

21

24

7

3

3

1

15

Mar
Feb
Jan

If you want to select non-contiguous columns or rows this can be done while holding down the Ctrl 
key.

 From the list above select only The Algebraist, The Kite Runner and Master and Commander. 
 Create a Bar chart from these. 
 Add a title to the top of the chart

Save this workbook as Book Sales
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3.5 Paste Options
3.5.1 Paste Link 
Paste link allows you to copy data between sheets and even applications such that when the source 
data is updated the copied data is also updated. Obviously both the source and the destination 
documents need to be accessible.

 Create a sheet called January and enter the following pairs of data: North £24,945; East 
£32,345 South £42,945 West £18,943

 Now create two more sheets February and March and enter the appropriate data sets
 Feb North £16,234; East £27,834; South £36,152; West £17,344.
 Mar North £25,234; East £23,435; South £42,673; West £16,848.
 Finally create a Summary sheet and move this to the first position 

of the worksheet tabs.

Suppose we want to collect all the totals for the first quarter and 
summarise them on their own Summary sheet, along with a graph of the 
results on yet another separate sheet.  To do this we need to first sum the 
area totals on the monthly sheets. Now copy the totals to the summary 
sheet using the paste link option. Now any change to the source data will 
be reflected in the summary sheet and the associated chart. You may 
notice the syntax of the link is Sheet1!A1 where Sheet1 is the sheet where 

the data comes from and A1 is the cell in that sheet that you want to copy. 

(You can also add cells using this approach. For example =Sheet1!A1+Sheet2!A1+Sheet3!A1 will add 
the first cells in all three sheets.)

3.6 The View Ribbon
3.6.1 Adding to the View
The Show group on the View ribbon allows you to change what is shown on the screen. The settings 
are:

Show gridlines (NOT the printable gridlines! see Page setup below for these), 

Show Formula bar, the bit where you see your calculations.

Show Headings, the column letters and the row numbers. 

3.6.2 Freeze panes
When looking at a large worksheet it is easy to lose your frame of reference and it can be tedious 
using the scroll bar to identify which column or row you are on. To alleviate this problem it is possible
to freeze the first row or column, indeed you can freeze more than one row / column. The Window 
group on the View Ribbon has the Freeze Panes icon for just this purpose.

3.6.3 Multiple Workbooks
You can have more than one workbook open at any one time. You can quickly view each workbook 
by selecting it with the Switch Windows icon also on the View ribbon. If you regularly work on more 
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than one workbook then you can save them as a set with the Save Workspace icon. This allows you 
to open them together rather than individually, useful if you don’t like remembering the file names 
you were using to complete a piece of work. By default the workbooks collectively have the .xlw 
extension and are given the default name resume.xlw, you can of course choose your own. 

You can also view workbooks side by side both horizontally and vertically or hide them if you want to 
focus only on one. These commands come under the window group 

The Split icon allows you to divide up the screen into 2 or four parts that move in sync with each 
other. Four is the initial setting but dragging the dividers to the top or to the side causes one or both 
of them to disappear.

3.6.4 Multiple Worksheets. 

On the Home tab in the Cells group you can: Insert, or Delete a sheet.

You can also Organise Sheets such as Rename, Move or Copy and Colour a Sheet tab.
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3.7 Protection
Protection of the entire workbook can be achieved via the File tab Info 

By default, the Locked setting is turned on for every cell in a worksheet. This is confusing, because 
the locked setting doesn’t actually apply until you select the Protect Sheet command. That’s why it’s 
considered best practice to unlock the entire sheet before you start.
To do this select all cells with the select all button, above the 1 and to the left of A. The whole sheet 
should be highlighted. On the Home tab select the Number group dialogue box launcher to open the
Number dialogue box. Select the Protection tab and uncheck the locked check box. 

3.8 Lists
Excel has built in lists days of the week, months of the year it. (You have used the Autofill cross to fill 
a row or column with these lists). It is however possible to create your own lists, specific to particular
task.

Type the list you want into a new sheet and highlight it. The list here is the positions in a rugby team.

Loosehead prop, Hooker, Tighthead prop, Number-4 Lock, Number-5 Lock, Blindside-flanker, 
Number-8, Openside-flanker, Scrum-half, Fly-half, Left-wing, Inside-Centre, Outside-Centre, Right-
Wing

From the File tab select Options, then Advanced and from the bottom of this list select Edit Custom 
Lists. Now click Import and the list you highlighted will be added to the lists already available.
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3.9 Page Setup options

         

3.9.1 Page tab lets you select the orientation of your sheet, the size of the paper you use, the print quality and the page numbering. It is also where you 
can force your sheet to print on only one sheet of paper. This can be very usefull but you will have to take care that for larger sheets the text is readable.

3.9.2 Margins tab gives you full control of the size of the margins that will be used. You will need to know if your printer can print right to the end of a 
sheet. Not all printers can. Notice you can centre your work both horizontally and vertically.

3.9.3 Header/Footer tab gives you a limited choice of options which can be selected with the dropdown arrow to the right of the box or you can add a 
custom choice by clicking the appropriate button.

3.9.4 Sheet tab provides a variety of print options including gridlines and row and column headings

Note: These dialogue boxes are also available from the Print Preview screen. File tab –> Print –> Page Setup 

3.10 Searching and Sorting
3.10.1 Sort and Filter
These functions are accessed through the Data ribbon or the Home ribbon
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Data Ribbon Home Ribbon

  

Open the Excel file Sort.xlsx from the student drive and select the Sort sheet at the bottom of the current workbook. Click on the Data tab to open the Data 
ribbon. In the Sort and Filter group select the Sort icon. Because this data table has Columns it is necessary to tick the “My data has headers” check box. 
Doing this will give you column names rather than letters. 

Sort the data by Last name (Sname) then First name (Fname).  You need to click “Add level” to get the second sort.
Now sort the data by Town then Post code (Pcode)
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To use the Filter function you first have to turn it on by clicking the Filter icon on the Data ribbon. Once on, the Headers have drop down buttons attached to
them. 

Use these to display only Newport addresses, followed by addresses in Newport and Swansea city centres SA1 and NP1

Additionally Numbers can be sorted into top 10 above average etc. Dates into this month, last quarter etc. Use Points and Last contact to experiment with 
these.
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4 ECDL Excel level 2 Syllabus
4.1 Using the Application
4.1.1 Working with Spreadsheets
4.1.1.1 Open, close a spreadsheet application. Open, close spreadsheets.

4.1.1.2 Create a new spreadsheet based on default template.

4.1.1.3 Save a spreadsheet to a location on a drive. Save a spreadsheet under another name to a location on a drive.

4.1.1.4 Save a spreadsheet as another file type like: template, text file, software specific file extension, version number.

4.1.1.5 Switch between open spreadsheets.

4.1.2 Enhancing Productivity
4.1.2.1 Set basic options/preferences in the application: user name, default folder to open, save spreadsheets.

4.1.2.2 Use available Help functions.

4.1.2.3 Use magnification/zoom tools.

4.1.2.4 Display, hide built-in toolbars. Restore, minimize the ribbon.

4.2 Cells
4.2.1 Insert, Select
4.2.1.1 Understand that a cell in a worksheet should contain only one element of data, (for example, first name detail in one cell, surname detail in 
adjacent cell).

4.2.1.2 Recognize good practice in creating lists: avoid blank rows and columns in the main body of list, insert blank row before Total row, ensure cells 
bordering list are blank.

4.2.1.3 Enter a number, date, text in a cell.

4.2.1.4 Select a cell, range of adjacent cells, range of non-adjacent cells, entire worksheet.

4.2.2 Edit, Sort
4.2.2.1 Edit cell content, modify existing cell content.

4.2.2.2 Use the undo, redo command.

4.2.2.3 Use the search command for specific content in a worksheet.
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4.2.2.4 Use the replace command for specific content in a worksheet.

4.2.2.5 Sort a cell range by one criterion in ascending, descending numeric order, ascending, descending alphabetic order.

4.2.3 Copy, Move, Delete
4.2.3.1 Copy the content of a cell, cell range within a worksheet, between worksheets, between open spreadsheets.

4.2.3.2 Use the autofill tool/copy handle tool to copy, increment data entries.

4.2.3.3 Move the content of a cell, cell range within a worksheet, between worksheets, between open spreadsheets.

4.2.3.4 Delete cell contents.

4.3 Managing Worksheets
4.3.1 Rows and Columns
4.3.1.1 Select a row, range of adjacent rows, and range of non-adjacent rows.
4.3.1.2 Select a column, range of adjacent columns, and range of non-adjacent columns.
4.3.1.3 Insert, delete rows and columns.
4.3.1.4 Modify column widths, row heights to a specified value, to optimal width or height.
4.3.1.5 Freeze, unfreeze row and/or column titles.

4.3.2 Worksheets
4.3.2.1 Switch between worksheets.

4.3.2.2 Insert a new worksheet, delete a worksheet.

4.3.2.3 Recognize good practice in naming worksheets: use meaningful worksheet names rather than accept default names.

4.3.2.4 Copy, move, and rename a worksheet within a spreadsheet.

4.4 Formulas and Functions
4.4.1 Arithmetic Formulas
4.4.1.1 Recognize good practice in formula creation: refer to cell references rather than type numbers into formulas.

4.4.1.2 Create formulas using cell references and arithmetic operators (addition, subtraction, multiplication, division).

4.4.1.3 Identify and understand standard error values associated with using formulas: #NAME?, #DIV/0!, #REF!.

4.4.1.4 Understand and use relative, absolute cell referencing in formulas.

4.4.2 Functions
4.4.2.1 Use sum, average, minimum, maximum, count, counta, round functions.
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4.4.2.2 Use the logical function if (yielding one of two specific values) with comparison operator: =, >, <. 

4.5 Formatting
4.5.1 Numbers/Dates
4.5.1.1 Format cells to display numbers to a specific number of decimal places, to display numbers with, without a separator to indicate thousands.

4.5.1.2 Format cells to display a date style, to display a currency symbol.

4.5.1.3 Format cells to display numbers as percentages.

4.5.2 Contents
4.5.2.1 Change cell content appearance: font sizes, font types.

4.5.2.2 Apply formatting to cell contents: bold, italic, underline, double underline.

4.5.2.3 Apply different colours to cell content, cell background.

4.5.2.4 Copy the formatting from a cell, cell range to another cell, cell range.

4.5.3 Alignment, Border Effects
4.5.3.1 Apply text wrapping to contents within a cell, cell range.

4.5.3.2 Align cell contents: horizontally, vertically. Adjust cell content orientation.

4.5.3.3 Merge cells and centre a title in a merged cell.

4.5.3.4 Add border effects to a cell, cell range: lines, colours.

4.6 Charts
4.6.1 Create
4.6.1.1 Create different types of charts from spreadsheet data: column chart, bar chart, line chart, pie chart.

4.6.1.2 Select a chart.

4.6.1.3 Change the chart type.

4.6.1.4 Move, resize, delete a chart.

4.6.2 Edit
4.6.2.1 Add, remove, edit a chart title.

4.6.2.2 Add data labels to a chart: values/numbers, percentages.

4.6.2.3 Change chart area background colour, legend fill colour.
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4.6.2.4 Change the column, bar, line, pie slice colours in the chart.

4.6.2.5 Change font size and colour of chart title, chart axes, chart legend text.

4.7 Prepare Outputs
4.7.1 Setup
4.7.1.1 Change worksheet margins: top, bottom, left, right.

4.7.1.2 Change worksheet orientation: portrait, landscape. Change paper size.

4.7.1.3 Adjust page setup to fit worksheet contents on a specified number of pages.

4.7.1.4 Add, edit, delete text in headers, footers in a worksheet.

4.7.1.5 Insert and delete fields: page numbering information, date, time, file name, worksheet name into headers, footers.

4.7.2 Check and Print
4.7.2.1 Check and correct spreadsheet calculations and text.

4.7.2.2 Turn on, off display of gridlines, display of row and column headings for printing purposes.

4.7.2.3 Apply automatic title row(s) printing on every page of a printed worksheet.

4.7.2.4 Preview a worksheet.

4.7.2.5 Print a selected cell range from a worksheet, an entire worksheet, number of copies of a worksheet, the entire spreadsheet, a selected chart.
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Appendix 1
Home Ribbon

Insert Ribbon

Page Layout Ribbon

Review Ribbon



View Ribbon
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